Computer Assisted Kinetic Evaluation (CAKE) Application
Version 3.3 Release Notes
Version 3.3 is a maintenanace release of CAKE that introduces a variety of fixes and enhancements. Version 3.0 was the last new major release of CAKE and included a
number of core changes to the application, most significantly an expanded topology, support for NAFTA kinetics and support for DFOP primary metabolites.

System Requirements
CAKE is officially supported and formally tested on the following operating systems:
Windows 7 (32 bit and 64 bit editions)
Windows 8.1 (64 bit edition)
Windows 10 (64 bit edition)
Other Windows operating systems from Windows XP onwards are likely to work but are not officially supported and testing has not been carried out on these platforms. It
is likely that nearfuture versions of CAKE will no longer run at all on Windows XP.
NAFTA spreadsheet functionality requires Microsoft Excel 2010 or newer to function correctly. Excel 2007 and earlier versions with compatibility packs will load the
spreadsheet, but not all statistical calculations will function correctly.

Installation
Installation is carried out by running the appropriate provided setup executable (32 bit or 64 bit). Any previous versions of CAKE will be removed from your system.
Application repair and uninstall can be carried out in the usual way in Windows.
CAKE requires the .NET Framework 4 Client Profile or higher installed on your system. This is builtin to Windows 8 and newer and most Windows 7 installations will
already have it; if you do not, the installer will download and install it automatically. Alternatively, you can download it directly from Microsoft at
http://www.microsoft.com/engb/download/details.aspx?id=24872 (http://www.microsoft.com/engb/download/details.aspx?id=24872).

Region Setting
Version 3.0 of CAKE was the first one to support both FOCUS and NAFTA regulations. Under FOCUS regulations, the usual SFO, DFOP, FOMC and HS models are
available. Under the newly supported NAFTA regulations, SFO, DFOP and IORE models are available as well as a "NAFTA Process" mode which runs SFO, DFOP and
IORE in a single sequence (for more details, see the CAKE builtin help documentation).
You can set your region in the Application Preferences dialog, available from the File menu in CAKE. You can select FOCUS, NAFTA or Both (which will enable all
features). When you start the application for the first time, your default region will be determined from your computer's regional settings (NAFTA for computers with United
States, Canada or Mexico regional settings, FOCUS otherwise).

Change History
New in Version 3.3
Fixes an issue preventing the application from launching on systems where the Locale was not set to English.

New in Version 3.2
Entering a new values on the Parameters tab and then starting a new fit immediately without first clicking outside the text box could cause the old parameter value
to be reported at the top of the fit report. This has been fixed.
It was previously possible to paste values from the clipboard containing tab characters into the field for compartment names. This could lead to a crash and data
corruption. This has now been fixed by filtering tab characters out from values pasted from the clipboard.
Clicking on a sink for an inactive compartment will no longer change the selected compartment to that compartment.
Some of the internal optimisation calculations could use incorrect values at interim steps if a metabolite initial concentration was unfixed. This could throw the final fit
step off by providing unreasonable initial values to it. This has been fixed.
Implicit formation fractions (expressing formation from compartments without a sink to their final metabolite) are now explicitly stated in fit reports.
If a fit sequence completes with formation fractions optimised to 1 from a compartment with a sink, CAKE will now draw attention to this and advise the user to
consider rerunning with better initial values and the sink disabled.
Fitted data point values that are smaller than the specified ODE solver tolerance are now rounded down to 0.
Data tab names can no longer be duplicated by doubleclicking on a tab to rename it.
Hockey stick fits and plots are now more accurate where breakpoints and/or time ranges are small.
For all graphs, the number of data points used to produce lines has been increased to improve accuracy.
Scrolling the mouse wheel when the Extra Metabolite Curves or Graphs for each Compartment dropdowns on the Current Fit tab have focus will no longer change
their values.
Under the right circumstances, models with DFOP primary metabolites could be marked as in need of saving when the user had not changed anything. This has
been fixed.
The mathematical model used for DFOP metabolites in versions 3.0 and 3.1 did not match that prescribed by FOCUS guidelines. This has been corrected.
NAFTA Process fit sequences no longer use SFO fitted parameters as the basis for initial values for the DFOP and IORE stages. The IORE N value is still estimated
automatically based on results from the SFO and/or DFOP stages where possible.
The process for recommending/highlighting a representative halflife on the NAFTA Process spreadsheet has been updated to match the latest guidelines.
DFOP models with long decay times sometimes had lines missing on some metabolite graphs. This has been fixed.
Using spaces in names for compartments will no longer cause odd behaviour and missing data.
DFOP models will now always report k1 as the faster rate by convention, transforming parameters after the optimisation process if required.
Ctrl+X can now be used to "cut" on the Data tab.
Changing the Graphs for each Compartment dropdown or the Generate Advanced Reports check box on the Current Fit tab will now reload any active report with
the chosen option.

Initial values for metabolite initial concentrations are now stated in fit reports.
Fitted values for unfixed metabolite initial concentrations are now used as initial values in subsequent steps, in common with other fitted parameters.
Study files that dated from version 2.2 or earlier and were opened in version 3.0 or newer could end up misbehaving with the IORE model until the file was saved
and reloaded (specifically, the IORE model was internally stuck on a parentonly topology and with default display names for compartments). This has been fixed.
The representative halflife for FOMC models, tFOMC, has been renamed in reports to DT90 / 3.32.
Long names for data sets and topology compartments are now handled better throughout the application and name length limits are applied more consistently.
It is no longer possible to use the Generate Advanced NAFTA Spreadsheet option while fits are running.
Fixed a case where it was possible to crash the option when pasting data on the data tab in a very particular way.
Minor user interface improvements.

New in Version 3.1
The calculation of the number of degrees of freedom used when determining ttest statistics and confidence intervals was incorrect in version 3.0 when there were
replicate time 0 observations for a compartment with a fixed initial concentration. This has been fixed.
CAKE previously displayed blank cells in reports where values could not be calculated for some reason. This has now been changed to "nd" (not determined) and
"N/A" (not applicable) as appropriate and there is additional guidance in the user documentation.
The user can no longer change metabolite model selections while a fit is running.
Decay times in reports now save and load consistently in a situation where some of them could not be determined during a fit.
Under very particular circumstances, the parameters tab in version 3.0 could show no metabolite model selection after loading a file. This has been fixed.

New in Version 3.0
The CAKE configurable topology is now more complex. Metabolites C1 and A3 have been added and more links are configurable, including horizontal links that can
be configured in either direction at each level.
Advanced users can now configure primary metabolites to be fitted to the DFOP model instead of the SFO model. Here, "primary metabolite" means metabolites
that have the overall parent compound as their only parent. This choice can be made on the Parameters tab.
The IORE model has been added to the available models list. The "N" parameter initial value is autoestimated by default; this can be changed from the Fit Options
dialog.
A new "NAFTA Process" fit is available. This runs SFO, DFOP and IORE in sequence with estimations of initial values for parameters applied at each step. The
fitting process is similar to the EPA's PestDFV tool.
A postprocessing spreadsheet intended for "NAFTA Process" fits has been added. Users can export their "NAFTA Process" fits to the spreadsheet to view summary
information, graphs and statistics in a form similar to the output from PestDFV. Additionally, advanced users can choose to combine any three parentonly fit reports
of any type that share a common data set and put the combined information onto the spreadsheet. The template for the spreadsheet is also usereditable: full
details in the builtin application help.
CAKE now provides a regional setting on the Application Preferences dialog. In "FOCUS" mode, the SFO, DFOP, FOMC and HS models are available; in "NAFTA"
mode, the SFO, DFOP and IORE models are available as well as the "NAFTA Process" fit; in "Both" mode, all features are available.
Splash/about screen updated to recognise Ian Hardy (Battelle) and Simon Ford (JSCi) as scientific advisors.
The backcalculated DT50 for FOMC models recommended by the FOCUS guidelines has been added to CAKE reports.
Improved the behaviour when the "rerun selected fits that exist already" option is disabled so that partially completed reports (from cancelling a run) are discarded
and run again.
The "Run Fit" menu option is now disabled while a fit is running.
The option to not save extra metabolite curves into files has now been removed. Extra metabolite curves will now be saved into CAKE Study Files whenever they
have been produced.
Improved the parameters grid so that parameters displayed as "automatic" provide a shortcut to the Fit Options dialog via double click (so that the user can easily
change these values to be manually entered).
Fixed a rare bug where chi squared values would be missing from reports if the fitted model produced an incalculably small concentration at a relevant time point.
Fixed the CAKE window sometimes losing focus as soon as a file is opened.
The calculation of the number of degrees of freedom used when determining ttest statistics and confidence intervals has been changed to exclude time zero
observations if and only if the corresponding time zero parameter is fixed, per latest industry advice. This means that many preexisting CAKE fits will show slightly
different statistics in this release.
Fixed an issue where copying and pasting whole data sheets within the CAKE application could fail.
Fixed an extremely rare crash that could occur in the middle of a fit operation.
Removed extra metabolite curves from CAKE reports where the metabolite either has a nonzero initial concentration or multiple parents: curves in these
circumstances were previously being calculated incorrectly. (Extra metabolite curves are also not available for DFOP metabolites.)
Improved hockeystick autoestimation of initial tb value so that it will not choose values outside bounds specified by the user.
Added additional validation to prevent users from entering invalid parameter configurations (e.g. an initial value that falls outside the bounds they have specified). In
addition, accidental nonnumeric input is now handled better.
Improved the behaviour of the big graph on the Properties tab. It will now handle custom compartment names correctly and more consistently select a fit line to
display when multiple suitable reports are present.
Added the missing page on application preferences to the documentation (it was accidentally excluded from the CAKE 2.2 installer).
64 bit CAKE will now use the 64 bit R interpreter in preference to the 32 bit one.
Fixed the MCMC optimiser putting additional redundant columns in the decay time tables in reports.
Fixed loaded CAKE study files claiming in reports that tb selection was automatic when it was not.
Fixed incorrect graphs at intermediate steps when running the OLS optimiser in combination with a metabolite with nonfixed initial concentration.
Various minor user interface improvements.

New in Version 2.2
Degrees of freedom for chi squared computations will now exclude observations at time 0 if and only if the corresponding parameter is fixed.
Fixed a crash that could occur when running fits with the "keep existing fits" option enabled but the "rerun selected fits that exist already" option disabled.
By default, CAKE will now choose the initial value for the breakpoint for hockey stick models automatically. This solves problems of convergence to suboptimal fits
when the initial value of the breakpoint is not chosen well, an issue that is inherent to the hockey stick model for the numerical solvers that CAKE uses. Users can
still elect to choose an initial value manually if they turn this option off in the "Fit Options".
Fixed a crash that could occur under some circumstances when a longrunning fit was stopped in progress and then another fit started in its place.
Under certain circumstances, improved the convergence of the iteratively reweighted least squares process when the extra solver is disabled.
A sink being disabled is now correctly read in from saved CAKE Study Files.

Reduced the "as an image" size of graphs placed on the clipboard. Pasting into Office applications "as an image" will now render at a sensible size.
Improved the efficiency of chi squared calculations, in line with a change in mkin version 0.922.
Prevented a crash that could occur when attempting to view reports that contained incomplete fit information.
Improved the wording of a couple of error messages.
Added an option for the user to specify their preferred paper size for reports as either A4 or US Letter (relevant when opening in or copying to external programs
such as Microsoft Word). This option is set on the new Application Preferences dialog, accessible from the File menu. When you first run this version of CAKE, it will
automatically select US Letter for users with a USA or Canada Windows regional setting and A4 for all other users.

New in Version 2.1
The use of the "extra solver" is no longer controlled from the "Fit Options" dialog and CAKE will no longer prompt users about using the "extra solver" in the middle
of fits. Instead, users now make a choice about using the extra solver when starting a run: "Never", "If Required" or "Always (where possible)".
Confidence intervals for decay parameters have been reintroduced into CAKE in line with updated guidance from the European Food Safety Authority.
Fixed a bug where 95% confidence interval upper limits were not being loaded correctly from saved CAKE Study Files.
Fixed a bug where graphs would sometimes not be plotted if the decay parameter for a metabolite was fixed.
Fixed a bug where statistics produced from the R library for the "extra solver" were sometimes wildly erroneous. We have worked around this issue in CAKE by no
longer relying on the "extra solver" R library for these statistics.
Fixed an issue where the iteratively reweighted least squares method would sometimes fail to iterate and reweight when running with the "extra solver" turned on.
Fixed a crash that could occur if the user right clicked on the report area while it was empty.
Fixed an error where chi squared information was reported with one too few degrees of freedom when running a model with every parameter fixed.
Fixed incorrect DT50/DT90 values for the DFOP model that could occur when the correct values were very large (e.g. due to very slow decay in the asymptotically
dominant term in the model). DT50/DT90 values cannot be determined analytically for the DFOP model, but the robustness of the numerical calculation has been
improved. Additionally, all DT50/DT90 values larger than 10,000 days now simply report as ">10,000" in CAKE reports.
Fixed a bug with pasting data into the data tab in CAKE where empty cells could get lost if pasting individual columns.
Increased the default value of tb for Hockey Stick models from 1 day to 10 days.
Changed the CSV import process so that it will not store any data within CAKE files that it cannot positively associate with a substance in the application.
Fits for metabolites with no associated observation data are now plotted in CAKE.
Fixed bugs with using custom names for compartments where data could apparently go missing from the data tab (particularly when switching columns around) and
old custom names could remain internally within the CAKE study file (but not be visible within the application).
Improved the automatic naming of new data sheets so that it does not duplicate existing names.

Known Issues
Known Issues in Version 3.2
Under some circumstances, CAKE gets stuck when the "Stop" button is pressed during a fit. The precise circumstances under which this happens have not been
identified yet. Users can work around this problem by saving their current file and then reopening it.
Calculation of DFOP decay times sometimes fails if the estimated values of k1 and/or k2 are very large.
The topology may partially disappear behind the main display area for users with nonstandard Windows DPI settings (in particular, the "medium" setting). Users
can work around this by manually expanding the size of the topology panel.

Not CAKE Issues
Pasting graphs from CAKE into Microsoft PowerPoint can be unreliable. This is not a fault with CAKE, rather a problem in Microsoft PowerPoint (pasting images from
a rich text format document in Microsoft WordPad to Microsoft PowerPoint suffers from the same issues). Users can work around this problem by pasting "as an
image" in PowerPoint or first pasting into Microsoft Word and then copying from there to PowerPoint.
We have had reports from one particular userbase that CAKE is continuing to run in the background after it has been closed. Initial investigation suggested that this
may be caused by an incompatibility with some thirdparty software called Colligo Contributor, although we are still waiting for more data on this problem.

